


EPILEPSY WARNING
Please read before using this video gamie or allowing your children to use it.

Some people are susceptible to epileptic seizures or loss of consciousness when exposed to certain
flashing lights or light potterns in everyday life. Such people may have a seizure while watching
certain television images or playing certain video games. This may happen even if the person has
no medical history of epilepsy or has never had any epileptic seizures. If you or anyone in your
family has ever had symptoms related to epilepsy [seizures or loss of consciousness) when exposed
to flashing lights, consult your doctor prior to playing. We advise that parents should monitor the
use of video games by their children. If vou or vour child experience any of the following symptoms:
dizziness, blurred vision, eye or muscle twitches, loss of consciousness, disorientation, any
imvoluntary movement or comvulsion, while playing a video game, IMMEDIATELY discontinue use
and consult yvour doctaor.
Precautions to take during use
# [o not stant too close to the screen. 5it a good distance away from the television screen,

as far away as the length of the cable allows.
® Preferably play the game on a small television screen.
# Avoid playing if vou are tired or have not had much sleep.
* Make sure that the room in which you are playing is well lit.
# Rest for at least 10 to 15 minutes per hour while playing a video game.

Play more, feel better. ﬁ



Play more, feel better

onesong partners, inc. is composed of artists from a wide range of disciplines: designers, composers,
musicians, computer programmers, graphic artists, writers and entrepreneurs,

We are dedicated to the creation of powerful and beautiful life-enhancing, life-affirming
products including: multimedia CO-ROMs, video games, music CDs, books, film,
live entertainment and events.

Every onesong entertainment product is intended to uplift the heart and mind of its users.

The mission of onesong partners, inc. is to benefit humanity with each of our products and
to demonstrate that consciousness and good will are, in every way, the maost profitable
business practices.

onesong partners, inc. was founded in 1994 by Michael Jai Feinberg, Noah Clemence Zim,
Onye Onyemoechi and Paul Colerman.

£ 199% onesong partners, inc.
Published by Time Warner Interactive, No2 Carriage Row, Eversholt Street, London NW1 1BU.

International rights secured. Mot for broadcast transmission. All rights reserved. Do not duplicate.
Mot available for separate rental.

Endorfun is a trademark of onesong partners, inc.
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Installing Endorfun

Before You Proceed

Please check yvour Endorfun CO-ROM for a
READ ME file which contains late breaking
information about Endorfun. Insert into the CD-
ROM drive and double-click on the READ ME
file or open it from within any word processor.

Iif You Don’t Read Manuals...

If you are using Windows™ or Macintosh®
System 7.5 or above, vou'll find a help file in
Endorfun that contains most of the information
in this manual. Under System 7.5, lock in the
Apple Guide {7} menu. Nate: You must have the
Apple Guide extension installed in your Spstem
Folder. Under Windows, look in the Help menu.

System Requirements
* Macintosh Users:

Recommended minimum system requirements
for playing Endorfun is a 33 Mhz, 62030
Macintosh with a double-speed CD-ROM drive,
B MB of random access memory and System
7.1 aor higher. Recommended system: 33 Mhz,
GE0MD Macintosh.

* Windows Users:

Recommended minimum system requirements
for playing Endorfun is a 66 Mhz, 486 PC with a
double-speed CD-ROM drive, Windows35 or
Windows 3.1, and & MB of random access
memaory. Endorfun can play on less powerful
PCs, but you'll likely see some degrodation in
performance. See Optimizing Performance for
more details.

Installing the Game

Endorfun plays almost entirely from the CD-
ROM. The files installed on your hard drive are
only those necessary to launch the program,
save the scoreboards, and save games.
Installation will take only a few seconds.

A

To install Endorfun:

* Macintosh Users:

Endorfun plays entirely from the CO-ROM. To
play Endorfun: insert the CO-ROM, double-click
on the CD-ROM icon, then double-click on the
Endorfun game icon.

+* Windows Users:
1. Start Windows.

2. Place the Endorfun CD in your CO-ROM
drive.

3. Windows 3.1: At the Program Manager,
from the File menu, choose Run...

Windows35: Click the Start button in the
Taskbar and choose Run...

4. In the Run dialog, type the command:
[drive]:setup where [drive] is the letter
designation of your CD-ROM drive.

For example, if your CO-ROM drive is drive
D: you would type:

Dsetup

Click 0K in the Run dialog and follow the
on-scresen prompts to complete the setup
process.

Playing Endorfun

Endorfun is a game of colour and music,
rhvythms and patterns. It is also a game of
speed, patience and strategy. In less time than
you might initially imagine, playing Endorfun
will become virtually instinctive.

The main character in Endorfun is the Light
Body cube, which you, the player, control and
navigate with vour mouse or keyboard over the
Unified Field {the board composed of squares).

The Light Body cube has a different colowur on
each of its six sides. The most basic skill
required to play Endorfun successfully is the
ability to mowe the Light Body cube to any
square on the Unified Field and have the colour
of your choosing on the top of the cube.

Play more, feel better.




The pieces of the game known as Blocks and
Life Force appear on the Unified Field in the
same six colours that are on the sides of the
Light Body cube. You can only land on these
pieces with the Light Body cube if the colour
on the top side of the cube is the same as the
colour of the piece. When you land on a Life
Force square or Block and move off that square,
it will be empty because you have successfully
merged with - and thereby absorbed or
removed - the piece occupying that square.

Blocks come in two varieties: Simple Blocks and
Bonus Blocks. There are three types of Bonus
Blocks: Multipliers, Timers and Globals. Don't let
the Blocks trap you; merge with them to cdlear
the way, to gain more time, or to earn maore
points.

Absorb the Life Force, Remove the Blocks.

Practice moving the Light Body cube until you
can easily manoeuver it into any position. You'll
find some of the basic moves, or gambits, listed
later in this document.

You can move the Light Body cube with either
the mouse or the cursor (arrow) keys on the
kevboard. Try both to see which you prefer. If
you want to reassign the keyboard keys, see the
%et Keyboard Control option in the Options
menu.

Beginning an Experience
To begin a new game experience:

1. From the Game menu, choose Select New
Game.

2. Choose an experience from the Select Game
Experience dialog.

The radio buttons on the left side of the dialog
let you filter the list of games according to the
type of experience. There are three distinctive
types of game experiences in Endorfun. All of
the experiences use the same basic game

pieces, but the specific game objectives are
different.

Play more, feel better.

Quickening experiences challenge you to
complete the game as quickly as possible by
capturing Life Force. Your goal is to score the
fastest time. Speed and precision are
everything.

Longevity experience challenge you to play for
as long as you can. You want to achieve the
longest time. You'll need to complete each level
before the Unified Field fills up or the Timer runs
down.

Abundance experience challenge you to score
as many points as you can within the time
allowed. In many of these experiences, you'll
have a lot of mobility in the Unified Field, but
the Timer will force you to move from level to
level. In others you'll need to pay attention to
how quickly the Unified Field is filling with
Blocking Squares. You'll want to move on to the
next level before you're blocked in, no matter
how much time is left on the Timer.

Game Experience names in the dialog are
colour coded to indicate their approximate
difficulty level.

The Endgame

An Endorfun game experience can end one of
three ways:

* You win the game! In this case you are
rewarded with a special "win screen” which
lawds your accomplishment.

#* You lose the game because the Light Body
cube became trapped by blocks. A moment
after the Light Body becomes trapped, the
Unified Field rapidly fills with blocks and you
see a "lose screen”, which presents you with
a positive message. You then click the left
mouse button and see the "Cuick Play”
buttons and menu bar. Play again!

# You lose the game because the Timer ran out
of time. The Unified Field fills with blocks and

you see a “lose screen” with a positive message.

You then clock the left mouse button and see
the "Quick Play" buttons and menu bar. Play

again!

Za



The Game Pieces
Unified Field Blacks
Light Body
Like Force

Light Body (cube)

The cube shaped Light Body represents the
player, seeking Life Force, on the Unified Field.
You move the Light Body by moving the mouse
or by pressing the cursor {arrow) keys.

Unified Field

The playing field over which the Light Body
cube seeks Life Force. The Unified Field is an
ever changing mosaic of sguares (sometimes
transparent, other times opague) that usually
transforms its basic shape and point of view
whenever the player transcends to a new level.

Life Force

The pulsing squares on the Unified Field are the
Life Force the Light Body seeks. The majority of
the time there are several Life Force squares per
level, but there is only one Life Force square on
the Unified Field at a time. Each time the Light
Body cube merges with a Life Force square
another Life Force appears on the Unified Field.
When the final Life Force on a level is absorbed,
the Light Body transcends to the next level. The
Light Body merges with the Life Force by landing
on it with the same colour that is on the square
on the top-facing side of the cube.

Blacks

All of the coloured squares on the Unified Field
that are not Life Force are Blocks. There are two
basic types of Blocks: Simple Blocks and Bonus
Blocks. The Light Body cube merges with either
type of block by landing on top of it with the
same colour as the square showing on the top-

facing side of the cube.

]

Simple Blocks

The solid coloured squares on the Unified Field.
In Abundance game experiences, these blocks
have a point value. Ctherwise, they merely
block the was to Life Force.

Multiplier Blocks
]
- KX ES

In Cwickening and Longevity games, Multiplier
Blocks temporarily block the way to Life Force.
In Abundance games, they give a multiple of
the number of points assigned to the Simple
Blocks. The number of spots on the Multiplier
Blocks indicate the multiplier, so you can quickly
see the relative value of the block. For example,
if a Simple Block is worth 100 points, a
hultiplier Block with five spots on it will be
worth 500 points {100 x 5).

Timer Blocks

-
kd

C
Put time back on the Timer (in the Status Bar) so
you can stay on the level longer. Or, they slow
down the rate at which blocks are added to the
Unified Field. The number of sections on the
Timer Blocks give a hint as to how much time
they may be worth. Each section is worth 5
saconds, so the blocks are worth between 10
and 50 seconds of time. You don’t receive

points for merging with Timer Blocks.

Global Blocks

Remove all of the squares that are the same
colour as the Global Block, including Multiplier
and Time Blocks. When vou merge with a
Global, you receive the points for all of the
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Simple, Multiplier, and Global Blocks that are
removed from the Unified Field. BUT, you don't
receive the time from Timer Blocks. 5o, if you
need to get some time block, merge with the
available Timer Blocks before you merge with
the Global Blocks.

The Status Bars

The Status Bar at the top of the game window
displays valuable information while you are
playing Endorfun. There are actually three
slightly different Status Bars, and which one you
see depends on the type of game experience
you've selected.

T fervm | dewe F o 0| B

All of the Status Bars show:
¢ The name of the current game;
# The number of Life Force squares remaining
in the current level;
# The Level number;

#* The Timer, which shows the maximum time
vou can spend on a level before you must
transcend to the next level or lose the game.
The Timer area of the status bar will blink
when there are less than 30 seconds
remaining in a Level.

Cuickening Status Bars also show:
# The number of Levels in the game experience;
# The Elapsed Time [how long you've been
playing the game experience].

If a gamme Level has a Challenge Level
associated with it, the Timer area of the Status
Bar will show an asterisk [*] beside Timer.

Longevity Status Bars also show:
# The Elapsed Time [how long vou've been
playing the game experience).
Abundance Status Bars also show:

¢ The number of Levels in the game experience;
& The current score.

Play more, feel better.
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If a game Level has a Bonus Level associated
with it, the Score area of the Status Bar will
show an asterisk |*) beside Score. When you've
achieved the score required to earn the Bonus
Level, the Score area reverses | highlights).

The Gambits

This section explains some of the basic
manoceuvers the Light Body cube can use to
merge with a square on the Unified Field. This
is not a complete list, but it's a good place to
start toward mastering Endorfun. {Each gambit
here is described as a manoeuver toward
merging with a coloured square, but try to think
of them as a method of moving onto any
square]. As you master Endorfun, you’ll find
that you use these gambits and others in many
combinations.

The U

Any time the Light Body cube is beside a square
with the same colour on the top face, you can
merge with the square by moving in a U shape
in either direction around the square. This
gamibit is perhaps the most basic, and is often
used in combinations with itself and other
gamibits to merge with squares.

The Fence

The Fence is a logical extension of the U. Amy
time your Light Body cube is on a straight line
with a square with the same colour on its top
face, you can merge with the square by tipping



the Light Body one square off the line, rolling it one square, the two will merge if you roll the
to beside the square and tipping it back up onto  Light Body two squares to one side and then
the square. toward the coloured square.

The Double-U How to Pause/Resume an
Experience

To pause a game:

* Click the left mouse button.

To resume a paused game:

* Press Enter or Beturn on the keyboard.

Another extension of the U is the Double-L. s Click the left mouse button with the cursor
Ay time the Light Body is catty-corner with a inside the game window.
square and the same colour is on the top face,

you can merge by performing two U gambits # Choose Resume from the Game Menu.
in succession. The first U puts the Light Body
beside the sguare and the second U merges ﬂpﬂmiﬂnﬂ Performance

the two. If Endorfun appears to play sluggishly on your

computer you might try the following:

The 3-Space * Turn off the texture on the Light Body cube.

{From the Options menu, choose Display and
then choose Textured Cube.

* Reduce the size of the game window.

Also, while it will not speed overall
performance, if you are playing Endorfun with
a mouse, we recommend that you ensure that its

Perhaps the most obvious gambit but the one mechanism is clean. Being able to smoothly and
least used by beginning players. You'll need this  predictably roll the Light Body is a critical factor
one to become a master at merging in tight in advanced game play.

spaces. Any time the Light Body cube and a

square are separated by three squaresin a When you change the window size, the Status
straight line, and the Light Body has the same Bar will reconfigure itself to fit as best it can. In
colour on its top-facing side, moving directly some cases, it will drop the name of the game
toward the square will result in a merge. experience from the display. In other cases, it

will become a two-line Status Bar. In extreme
cases, where the window is very small, the

The L Status Bar will not be displayed at all.

Uninstalling Endorfun

* Macintosh Users:

Since Endorfun plays entirely from the CD-
ROM, you need only delete the Endorfun
Preferences Folder inside your System Folder.
You may also want to delete any saved games
from your hard drive.

Amytime the Light Body cube is diagonal to a
coloured square that is the same colour as its
top-facing side, and the two are separated by
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* Windows Users:

To uninstall Endorfun from your hard drive
with Windows setup, do the following:

Windows 3.1

1. From the Program Manager, delete the
Endorfun Program Group and its contents.

Z. From the File Manager, delete the Endorfun
directory and all of its contents,

The Files in this directory are the high scores
and best times tables and any saved games.

If you chose the "Quick Install" option, the
Endorfun directory is named "Endorfun” and
is in your Windows directory. If you used a
custom install, the directory may be named

something different or be in another location.

3. Delete the ENDORFUN.INI file from the
Windows directony.

Windowsa5:

1. From the Start Menu, choose Settings and
then Control Panels.

2. Double-Click on the Add/Remove Programs
icon to run the Install/Uninstall wtility.

3. At the Install/Uninstall Tab of the Add/
Remove Programs Properties window, select
Endorfun in the list of software that can be
automatically remowved.

4, Click the Add/Remove button.

5. If you've been recording your High Scores
and Best Times or have saved games in
progress, one more step is required to
completely remove Endorfun. From the
Windows Explorer, delete the onesong folder
and all of its contents. if you chose the
"Cuick Install" option, the cnesong folder is
named "onesong” and is in your Program
Files folder. If vou used a custom install, the
folder may have a different name or be in
another location.

Play more, feel better.
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The Philosophy of Endorfun

Dur intention was to create more than a game,
miore than a diversion.

We wanted Endorfun to be beautiful, uplifting,
and inspiring, to enrich your consciousness,
to open your heart, to touch your soul.

And to be fun.
We hope we have succeeded.

We make this offering to you in the spirit of;
Peace to all the Sisters and Brothers; Love to all
the Mothers and Fathers; Light to all the
Daughters and Sons; Freedom to all the Friends
and Lowers; Joy and Abundance to the Waorld;
Utmost Gratitude to the Life Force.

One Love. One Tribe. One World.
W wish you the best. We have given you ours.

onesong!

Subliminal Messages in Endorfun

The music in Endorfun contains subliminal
messages designed to help you feel good about
yourselt and the world around you. They are
designed to enhance your state of well-being
and personal ability. At the end of each gamie,
whether yvou win or lose, a positive message
appears on the screen to reinforce positive
thoughts. Below is a list of the subliminal
messages contained in Endorfun. We hope that
you will approve of, enjoy, and benefit fram
these messages.



| am safe
My heart is filled with joy
| am loved
I am healthy
| am strong
| can do anything
| am powerful
Riches flow into my life
| am in contraol
Ky life is full of meaning and pleasure
I feel joyful now
My body heals itself
I know what 1 want
I am free of dependency
I am a winner
Riches flow into my life
I am in harmony
| am at peace
I am strong and secure
| create the life that | want
I feel joyful now
| am beautiful
| achieve my highest goals
| am divinely guided
Rivers of riches are flowing to me
| create my own reality
| create what | want
| want joy and expansion
| create joyous relationships
I create joyous abundance
| create joyous health
| create joyvous safety
| create joyous love
| create jovous fun
I create joyous comfort
| create jovous work
I create joyous thoughts
| create joyous creation
I create joyous life
| use my power wisely and well
I do what feels right
| have everything | truly want
In my own way | am a genius
| love ryself
| receive everything | need
I am unique and special
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Today | expect the best
All iz well
What | desire is already mine
I create miracles
I trust in myself
Money is flowing abundantly into my life
| deserve the very best in life
I am a beautiful perfect spirit
| am the master of my life
| am now attracting everything | need
| expect pleasure and satisfaction
I choose life
It is saffe for me to be powerful
| forgive myself completely
There is enough of everything for everybody
| lave life
I am a wonderful person
| ami now in perfect health
| honour myself
My life is unlimited
I am naturally enlightened
I am the master of my life
I love doing my work
It’s OK for me to have everything | want
I am relaxed and centred
Abundance is my true state of being
| am now prosperous and happy
I am rich, well, and happy
| am beautiful and lovable
| am talented, intelligent and creative
| deserve the very best in life
I love the world and the world loves me
| don't have to try to please anyvone else
I am free and healthy
I lowve myself completely as 1 am
lam glad | was born
| love being alive
| love myself
| am good and | do good things
The world is a beautiful place to be
llove it the way it is
I ove myself the way | am
There is no opposition
It is easy to control my existence
| forgive myself
| imtend joyous survival
| am free
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Note: if you prefer to play Endorfun without the
benefit of the subliminal messages, wouw con turn
them off by playing the gome with sound effects
or no seund instead of with music. To do this,
open the Optons menu ond choose the Sound
option. Then choose yowr preferred setting from
the submenu.

Commands

Game Menu Commands

Select New Game...

Opens the Select Game Experience dialog
where you can choose a new game sxparience.

The radio buttons on the left side of the dialog
let you view the list of games according to the
type of experience. The three types of game
experience are JQuickening, Longevity, and
Abundance. For a complete explanation of
game experiences, please see page 5.

Replay Game

Restarts the currently selected game experience.

Resume Gome

Restarts a paused game. You can also restart a
paused game by pressing Enter or Return, or by
clicking the left mouse button with the cursor in
the game window.

Save Game

Saves the current game. If you haven't vet saved
the game using Save Game As, this option is
dimmed in the menu.

Sove Gome As...

Displays the Save Game dialog where you can
save the current game under a new file name.

Ploy Saved Game...

Displays the Open Game dialog where you can
open a saved game.

Exit

Exits Emdarfum.

)

Options Menu Commands
Sound

Lets you choose whether the game experiences
play with music, sound effects, or no sound.

Display

Lets vou choose whether the background images
animate and whether the Light Body cube is
shown with a texture. Background Animation is
a purely assthetic option, though it was also an
intended part of Endorfun’s dymamism. Turning
off the texture on the Light Body cube may
improve the performance of the game on slower
computers,

Show Game Siatus

Lets you choose whether the Game Status Bar is
displayed at the top of the game window during
play. The default is to show the status, since it
provides valuable information for completing
the experiences successfully.

Naote: if the gome window has been re-sized to
be very small, the Stotus Bor will not be

displayed.

Sove Game Alert

Lats you turn off the alert box that appears each
time you abort play before a game experience
has ended. This option is checked on by default.
If you don't expect to save your games, you

may want to turn this option off.

Quick Play Buttons

Lets you turn off the buttons that appear near
the bottom of the game window with the Replay
Game and Select New Game options. This
option is turned on by default, since the buttons
provide a quick way to play again without

going to the menu.

Nate: you can also reploy, select a new game,
ar play @ saved game by pressing r, m or p o
the keyboard respectively when the menu bar is
shown ot the top of the game window.
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Show Best Times...

Displays the Best Times board. In this dialog you
can view the best times for any saved
Quickening and Longevity games. The title bar
of the dialog will indicate whether the game
selected is a Longevity or Quickening game.
Times are not displayed for uncompleted
Quickening games.

Show High Scores...
Displays the High Scores board for Abundance

game experiences. In this dialog you can view

the high scores for any games that have high
scores recorded. The board shows both the
score and highest level achieved.

Set Mouse Sensitivity
Displays a dialog for adjusting the sensitivity of
the Light Body cube to movement of the mouse.

Naote: Same gome experiences are designed
with o Light Body cube that rolls very quickly or
very slowly. We suggest that you not atfempt to
compensate for this by adjusting the Mouse
Sensitivity, since the speed of Light Body
movement and mouse sensitivity are not

directly reflated.

Also, while it will not speed overall

performance, if you are playing Endorfun with

a mouse, we recommend that you ensure that its
mechanism is clean. Being able to smoothly and
predictably roll the Light Body is a critical factor
in advanced game play.

Set Keyboard Conirel
Displays a dialog for setting which kevs on the
kevboard move the Light Body cube.

To change the settings, click on the drop-down
lists for each of the directions of movement and

select the key assignment you want.

* Windaows Users:

When a drop-down list is active, you can go to
an alpha-numeric key by pressing that key on
the keyboard. For example, if you want the
letter “E" assigned as the key to move the cube
up, you could click on the "Cube Up" drop-
down list to activate it, press "&" on the
kevboard (e will appear as the highlighted item
in the list), and then click on "e" in the list to
select it

Note: the cursor {arrow) keys, which are the
defauwlt setting, are listed in the drop-down lists
as Left, Right, Up, and Down. You will find these
and the keys Home, End, Page Up, and Page
Dawn, at the battom of the lists. You cannot
reach these key assignments by pressing them
on the keyboard, becouse they are used by the
dialog to novigate the drop-down lists when
they are active.
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Warranty

Time Warner Interactive warrants to the original purchaser of this compuber software product that the media onwhich the software
programe are recorded will ke free from defects in materials and workmanship under normal use for a period of 30 days after the date
of arginal purchase (The Warranty Peried). During the Warranty Perkod defective media will be replaced free of charge If the original
product is rebarmed to the Retal outiet where ariginally parchased, with dated proof of purchase. This warranty is in additien to and
does nat aflect your statutory rights. This waranty does not apply to the softeane programs themselves which are provided sas ke,
nov does it apply to media which may have been subject to damage ar carrupton.

ﬁ Play more, feel better.
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